Information in this document is subject to change without notice.

LIFE TECHNOLOGIES CORPORATION AND/OR ITS AFFILIATE(S) DISCLAIM ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. TO THE EXTENT ALLOWED BY LAW, IN NO EVENT SHALL LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

NOTICE TO PURCHASER:

No right is conveyed expressly, by implication or by estoppel under any patent claim, such as claims to reagents, kits, or methods such as 5' nuclease methods, other than apparatus claims covering the purchased apparatus. Further information on purchasing licenses may be obtained by contacting the Director of Licensing, Life Technologies, 850 Lincoln Centre Drive, Foster City, California 94404, USA.

TRADEMARKS

The trademarks mentioned herein are the property of Life Technologies Corporation or their respective owners.

© 2012 Life Technologies Corporation. All rights reserved.
## Contents

### Preface
- How to Use This Guide .................................................. 5
- How to Obtain Support .................................................... 6
- Related Documentation .................................................... 6

### Safety and EMC Compliance Information
- Safety Conventions Used in This Document ......................... 8
- Symbols on Instruments .................................................. 9
- Safety Labels on Instruments ............................................ 11
- General Instrument Safety ............................................... 13
- Chemical Safety .......................................................... 14
- Chemical Waste Safety ................................................... 15
- Electrical Safety .......................................................... 16
- Physical Hazard Safety ................................................... 17
- Biological Hazard Safety ................................................ 17
- Workstation Safety ........................................................ 18
- Safety and Electromagnetic Compatibility (EMC) Standards .......... 19

### Chapter 1
- **Powering On the 7500 Fast Dx Real-Time PCR Instrument** 21
  - Powering On the 7500 Fast Dx Real-Time PCR Instrument ............ 22
  - Troubleshooting ....................................................... 23

### Chapter 2
- **Performing the Background Calibration** 25
  - About the Background Calibration ................................... 26
  - Creating a Background Plate ................................……. 27
  - Creating a Plate Document for the Background Calibration ........ 28
  - Performing the Background Calibration ................................ 29
  - Analyzing the Background Calibration Data .......................... 30
  - Troubleshooting ....................................................... 33
Preface

How to Use This Guide

Intended Use

The Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument with the SDS Software version 1.4 is a real-time nucleic acid amplification and detection system that measures nucleic acid signals from reverse transcribed RNA and converts them to comparative quantitative readouts using fluorescent detection of dual-labeled hydrolysis probes. The 7500 Fast Dx Real-Time PCR Instrument is to be used only by technologists trained in laboratory techniques, procedures, and on use of the analyzer.

CAUTION! The protection provided by the equipment may be impaired if the instrument is operated outside the environment and use specifications, the user provides inadequate maintenance, or the equipment is used in a manner not specified by the manufacturer (Life Technologies).

Assumptions

This manual assumes that you:

• Have available manufacturer's documentation for the assays you are performing.
• Are familiar with the Microsoft® Windows® XP operating system.
• Understand general techniques for preparing and handling DNA and RNA samples.
• Have a general understanding of hard drives and data storage, file transfers, and copying and pasting.

Text Conventions

This guide uses the following conventions to make text easier to understand:

• Bold indicates user action. For example:
  Type 0 and press Enter for the remaining fields.
• Italic text denotes new or important words and is also used for emphasis. For example:
  Before performing a run, you must calibrate the instrument.
• A right arrow ( › ) separates successive commands you select from a drop-down or shortcut menu. For example:
  Select  All Programs  ›  Applied Biosystems  ›  7300/7500 Fast System  ›  7500 System Software.

User Attention Words

Two user attention words appear in Life Technologies user documentation. Each word implies a particular level of observation or action as described below:

Note – Provides information that may be of interest or help but is not critical to the use of the product.

IMPORTANT! – Provides information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.
Examples of the user attention words appear below:

**Note:** Before starting the run, the instrument may pause (up to 10 minutes) to allow the heated cover to reach the correct temperature.

**IMPORTANT!:** Wear powder-free gloves when you handle the halogen lamp.

**Safety Alert Words**

Safety alert words also appear in user documentation. For more information, see “Safety Alert Words” on page 8.

**How to Obtain Support**

For the latest services and support information for all locations, go to [http://www.lifetechnologies.com](http://www.lifetechnologies.com), then click the link for **Support**.

At the Support page, you can:

- Obtain worldwide telephone and fax numbers to contact Life Technologies Technical Support and Sales facilities
- Search through frequently asked questions (FAQs)
- Submit a question directly to Technical Support
- Download PDF documents
- Obtain information about customer training

**Related Documentation**

Portable document format (PDF) versions of the following related documents are available on a CD which is shipped with the Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument:

<table>
<thead>
<tr>
<th>Document</th>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
</table>

A portable document format (PDF) version of the following guide is sent by email after you place an order for the Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument:

<table>
<thead>
<tr>
<th>Document</th>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument Site Preparation Guide</td>
<td>4440092</td>
<td>Provides information about the space, environmental, and electrical requirements needed to support the 7500 Fast Dx Real-Time PCR Instrument</td>
</tr>
</tbody>
</table>

**Note:** For additional documentation, see “How to Obtain Support” on page 6.
Safety and EMC Compliance Information

This section includes the following topics:

- Safety Conventions Used in This Document .............................. 8
- Symbols on Instruments .................................................. 9
- Safety Labels on Instruments .............................................. 11
- General Instrument Safety .................................................. 13
- Chemical Safety ............................................................. 14
- Chemical Waste Safety ...................................................... 15
- Electrical Safety ............................................................. 16
- Physical Hazard Safety ...................................................... 17
- Biological Hazard Safety .................................................... 17
- Workstation Safety .......................................................... 18
- Safety and Electromagnetic Compatibility (EMC) Standards .......... 19
Safety Conventions Used in This Document

Four safety alert words appear in Life Technologies user documentation at points in the document where you need to be aware of relevant hazards. Each alert word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of observation or action, as defined below:

Definitions

IMPORTANT! – Indicates information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

⚠️ CAUTION – Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

⚠️ WARNING – Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

⚠️ DANGER – Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. This signal word is to be limited to the most extreme situations.

Except for IMPORTANTs, each safety alert word in an Life Technologies document appears with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard icons that are affixed to instruments (see “Safety Symbols” on page 9).

Examples

The following examples show the use of safety alert words:

**IMPORTANT!** Wear powder-free gloves when you handle the halogen lamp.

⚠️ CAUTION The lamp is extremely hot. Do not touch the lamp until it has cooled to room temperature.

⚠️ WARNING CHEMICAL HAZARD. Ethanol is a flammable liquid and vapor. Exposure causes eye, skin, and respiratory tract irritation and may cause central nervous system depression and liver damage. Read the SDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

⚠️ DANGER ELECTRICAL HAZARD. Failure to ground the instrument properly can lead to an electrical shock. Ground the instrument according to the provided instructions.
Symbols on Instruments

The following table describes the electrical symbols that may be displayed on Life Technologies instruments.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol" alt="On" /></td>
<td>Indicates the On position of the main power switch.</td>
</tr>
<tr>
<td><img src="symbol" alt="Off" /></td>
<td>Indicates the Off position of the main power switch.</td>
</tr>
<tr>
<td><img src="symbol" alt="Standby" /></td>
<td>Indicates a standby switch by which the instrument is switched on to the Standby condition. Hazardous voltage may be present if this switch is on standby.</td>
</tr>
<tr>
<td><img src="symbol" alt="On/Off" /></td>
<td>Indicates the On/Off position of a push-push main power switch.</td>
</tr>
<tr>
<td><img src="symbol" alt="Ground" /></td>
<td>Indicates a terminal that may be connected to the signal ground reference of another instrument. This is not a protected ground terminal.</td>
</tr>
<tr>
<td><img src="symbol" alt="Grounding" /></td>
<td>Indicates a protective grounding terminal that must be connected to earth ground before any other electrical connections are made to the instrument.</td>
</tr>
<tr>
<td><img src="symbol" alt="Alternating" /></td>
<td>Indicates a terminal that can receive or supply alternating current or voltage.</td>
</tr>
</tbody>
</table>

Safety Symbols

The following table describes the safety symbols that may be displayed on Life Technologies instruments. Each symbol may appear by itself or in combination with text that explains the relevant hazard (see “Safety Labels on Instruments” on page 11). These safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that occur in the text of this and other product-support documents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol" alt="Warning" /></td>
<td>Indicates that you should consult the manual for further information and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="symbol" alt="Shock" /></td>
<td>Indicates the presence of an electrical shock hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="symbol" alt="Hot" /></td>
<td>Indicates the presence of a hot surface or other high-temperature hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="symbol" alt="Laser" /></td>
<td>Indicates the presence of a laser inside the instrument and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="symbol" alt="Moving Parts" /></td>
<td>Indicates the presence of moving parts and to proceed with appropriate caution.</td>
</tr>
</tbody>
</table>
Conforming symbols

The following table describes symbols that may be displayed on Life Technologies instruments, consumables, or reagents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![IVD]</td>
<td>IN VITRO DIAGNOSTIC MEDICAL DEVICE</td>
</tr>
</tbody>
</table>
| ![CE] | Conformité Européenne  
This symbol indicates European conformity. |
| ![flask] | FOR IVD PERFORMANCE EVALUATION ONLY  
IVD performance evaluation symbol. |
| ![i] | CONSULT INSTRUCTIONS FOR USE |
| ![calendar] | DATE OF MANUFACTURE |
| ![EC REP] | AUTHORISED REPRESENTATIVE IN THE EUROPEAN COMMUNITY  
The name and the address of the authorised representative in the European community will appear next to this symbol. |
| ![flag] | MANUFACTURER  
The name and the address of the manufacturer will appear next to this symbol. |
| ![SN] | SERIAL NUMBER |

Environmental Symbols on Instruments

The following symbol applies to all Life Technologies electrical and electronic products placed on the European market after August 13, 2005.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![waste] | Do not dispose of this product as unsorted municipal waste. Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of waste electrical and electronic equipment (WEEE).  
**European Union customers:**  
Call your local Life Technologies Customer Service office for equipment pick-up and recycling. See [http://www.lifetechnologies.com](http://www.lifetechnologies.com) for a list of customer service offices in the European Union. |
Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on Life Technologies instruments in combination with the safety symbols described in the preceding section.

<table>
<thead>
<tr>
<th>English</th>
<th>Français</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAUTION</strong> Hazardous chemicals. Read the Material Safety Data Sheets (SDSs) before handling.</td>
<td><strong>ATTENTION</strong> Produits chimiques dangereux. Lire les fiches techniques de sûreté de matériels avant la manipulation des produits.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> Hazardous waste. Refer to SDS(s) and local regulations for handling and disposal.</td>
<td><strong>ATTENTION</strong> Déchets dangereux. Lire les fiches techniques de sûreté de matériels et la régulation locale associées à la manipulation et l’élimination des déchets.</td>
</tr>
<tr>
<td><strong>WARNING</strong> Hot lamp.</td>
<td><strong>AVERTISSEMENT</strong> Lampe brûlante.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> Hot surface.</td>
<td><strong>ATTENTION</strong> Surface brûlante.</td>
</tr>
<tr>
<td><strong>DANGER</strong> High voltage.</td>
<td><strong>DANGER</strong> Haute tension.</td>
</tr>
<tr>
<td><strong>WARNING</strong> To reduce the chance of electrical shock, do not remove covers that require tool access. No user-serviceable parts are inside. Refer servicing to Life Technologies qualified service personnel.</td>
<td><strong>AVERTISSEMENT</strong> Pour éviter les risques d’électrocution, ne pas retirer les capots dont l’ouverture nécessite l’utilisation d’outils. L’instrument ne contient aucune pièce réparable par l’utilisateur. Toute intervention doit être effectuée par le personnel de service qualifié de Life Technologies.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> Moving parts.</td>
<td><strong>ATTENTION</strong> Parties mobiles.</td>
</tr>
<tr>
<td><strong>WARNING</strong> This instrument is designed for 12V, 75W Halogen lamps only.</td>
<td><strong>AVERTISSEMENT</strong> Cet instrument est conçu pour des lampes d’halogène de 12V et 75W seulement.</td>
</tr>
</tbody>
</table>
Locations of Warnings

The Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument contains warnings at the locations shown below.
General Instrument Safety

**WARNING PHYSICAL INJURY HAZARD.** Use this product only as specified in this document. Using this instrument in a manner not specified by Life Technologies may result in personal injury or damage to the instrument.

**Moving and Lifting the Instrument**

**CAUTION PHYSICAL INJURY HAZARD.** The instrument is to be moved and positioned only by the personnel or vendor specified in the applicable site preparation guide. If you decide to lift or move the instrument after it has been installed, do not attempt to lift or move the instrument without the assistance of others, the use of appropriate moving equipment, and proper lifting techniques. Improper lifting can cause painful and permanent back injury. Depending on the weight, moving or lifting an instrument may require two or more persons.

**Operating the Instrument**

Ensure that anyone who operates the instrument has:

- Received instructions in both general safety practices for laboratories and specific safety practices for the instrument.
- Read and understood all applicable Material Safety Data Sheets (SDSs). See “About SDSs” on page 14.

**WARNING PHYSICAL INJURY HAZARD.** Use this instrument as specified by Life Technologies. Using this instrument in a manner not specified by Life Technologies may result in personal injury or damage to the instrument.
Cleaning or Decontaminating the Instrument

CAUTION CLEANING AND DECONTAMINATION

- If hazardous materials are spilled onto the instrument, the instrument should be appropriately decontaminated.
- Using cleaning or decontamination methods other than those recommended by the manufacturer may compromise the safety or quality of the instrument.
- Care should be taken to not use decontamination or cleaning agents which would cause a hazard as a result of a reaction with parts of the equipment or with material contained in it.
- For the protection of others, ensure the instrument is properly decontaminated prior to having the instrument serviced at your facility or before sending the instrument for repair, maintenance, trade-in, disposal, or termination of a loan.
- Decontamination forms may be requested from customer service.

Chemical Safety

Chemical Hazard Warning

WARNING CHEMICAL HAZARD. Before handling any chemicals, refer to the Material Safety Data Sheet (SDS) provided by the manufacturer, and observe all relevant precautions.

WARNING CHEMICAL HAZARD. All chemicals in the instrument, including liquid in the lines, are potentially hazardous. Always determine what chemicals have been used in the instrument before changing reagents or instrument components. Wear appropriate eyewear, protective clothing, and gloves when working on the instrument.

WARNING CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

About SDSs

Chemical manufacturers supply current Material Safety Data Sheets (SDSs) with shipments of hazardous chemicals to new customers. They also provide SDSs with the first shipment of a hazardous chemical to a customer after an SDS has been updated. SDSs provide the safety information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to replace the appropriate SDS in your files.

Obtaining SDSs

You can obtain from Life Technologies the SDS for any chemical supplied by Life Technologies. This service is free and available 24 hours a day.

To obtain SDSs:
1. Go to www.lifetechnologies.com, select Support, then select SDS.

2. In the Keyword Search field, enter the chemical name, product name, SDS part number, or other information that appears in the SDS of interest, then select Search.

3. Find the SDS of interest, select the link or right-click the SDS title, then select any of the following:
   - Open – To view the SDS
   - Print Target – To print the SDS
   - Save Target As – To download a PDF version of the SDS

Chemical Safety Guidelines

To minimize the hazards of chemicals:

- Read and understand the Material Safety Data Sheets (SDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. (See “About SDSs” on page 14.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the SDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the SDS.
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended on the SDS.
- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.

Chemical Waste Safety

HAZARDOUS WASTE. Refer to Material Safety Data Sheets and local regulations for handling and disposal.

Chemical Waste Safety Guidelines

To minimize the hazards of chemical waste:

- Read and understand the Material Safety Data Sheets (SDSs) provided by the manufacturers of the chemicals in the waste container before you store, handle, or dispose of chemical waste.
- Provide primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the SDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the SDS.
• Handle chemical wastes in a fume hood.
• After emptying the waste container, seal it with the cap provided.
• Dispose of the contents of the waste tray and waste bottle in accordance with good laboratory practices and local, state/provincial, or national environmental and health regulations.

Waste Disposal

If potentially hazardous waste is generated when you operate the instrument, you must:
• Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
• Ensure the health and safety of all personnel in your laboratory.
• Ensure that the instrument waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.

Electrical Safety

⚠️ DANGER ELECTRICAL SHOCK HAZARD. Severe electrical shock can result from operating the Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument without its instrument panels in place. Do not remove instrument panels. High-voltage contacts are exposed when instrument panels are removed from the instrument.

⚠️ WARNING FIRE HAZARD. Improper fuses or high-voltage supply can damage the instrument wiring system and cause a fire. Before turning on the instrument, verify that the fuses are properly installed and that the instrument voltage matches the power supply in your laboratory.

⚠️ WARNING FIRE HAZARD. For continued protection against the risk of fire, replace fuses only with fuses of the type and rating specified for the instrument.

⚠️ DANGER ELECTRICAL HAZARD. Grounding circuit continuity is vital for the safe operation of equipment. Never operate equipment with the grounding conductor disconnected.

⚠️ DANGER ELECTRICAL HAZARD. Use properly configured and approved line cords for the voltage supply in your facility.

⚠️ DANGER ELECTRICAL HAZARD. Plug the system into a properly grounded receptacle with adequate current capacity.
Overvoltage Rating

The Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument has an installation (overvoltage) category of II, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts

WARNING PHYSICAL INJURY HAZARD. Moving parts can crush and cut. Keep hands clear of moving parts while operating the instrument. Disconnect power before servicing the instrument.

Biological Hazard Safety

General Biohazard

WARNING BIOHAZARD. Biological samples such as tissues, body fluids, and blood of humans and other animals have the potential to transmit infectious diseases. Follow all applicable local, state/provincial, and/or national regulations. Wear appropriate protective eyewear, clothing, and gloves. Read and follow the guidelines in these publications:

In the U.S.:

- Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR§1910.1030; www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html)
- Your company’s/institution’s Biosafety Program protocols for working with/handling potentially infectious materials.
- Additional information about biohazard guidelines is available at: http://www.cdc.gov

In the EU:

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your workstation to promote neutral or relaxed working positions.

⚠️ CAUTION MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards are caused by potential risk factors that include but are not limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

- Use equipment that comfortably supports you in neutral working positions and allows adequate accessibility to the keyboard, monitor, and mouse.
- Position the keyboard, mouse, and monitor to promote relaxed body and head postures.
Safety and Electromagnetic Compatibility (EMC) Standards

This section provides information on:

- U.S. and Canadian Safety Standards
- Canadian EMC Standard
- European safety and EMC standards
- Australian EMC Standards

**U.S. and Canadian Safety Standards**

This instrument has been tested to and complies with standard UL 61010A-1, “Safety Requirements for Electrical Equipment for Laboratory Use, Part 1: General Requirements” and with standard UL 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use, Part 1: General Requirements.”

**Canadian EMC Standard**

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial, Scientific, and Medical Radio Frequency Generators.

**European safety and EMC standards**

**Safety**

This instrument meets European requirements for safety. This instrument has been tested to and complies with standards EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory Use, Part 1: General Requirements.”

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

EN 61010-2-101, “Particular Requirements for in vitro diagnostic (IVD) medical equipment.”

**EMC**

EN 61326-1:2006 “Electrical equipment for measurement, control and laboratory use - Part 1 General EMC requirements.” (Group 1, Class B)

The Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument has been tested to and complies with standard EN 61326-2-6, “Electrical Equipment for Measurement, Control, and Laboratory Use – EMC Requirements. Particular requirements, In vitro diagnostic (IVD) medical equipment.”

**Australian EMC Standards**

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
Safety and EMC Compliance Information

Safety and Electromagnetic Compatibility (EMC) Standards
Chapter 1

Powering On the 7500 Fast Dx Real-Time PCR Instrument

Powering On the 7500 Fast Dx Real-Time PCR Instrument

Performing the Background Calibration

Troubleshooting

Powering Off the 7500 Fast Dx Real-Time PCR Instrument

Notes

Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument Reference Guide
Powering On the 7500 Fast Dx Real-Time PCR Instrument

IMPORTANT! Do not power on the instrument unless the SDS software has been installed. If you power on the instrument before the SDS software is installed, the Windows operating system installs a generic driver for the instrument, which does not allow the instrument to communicate with the SDS software.

IMPORTANT! Make sure that the computer Hibernate power setting is disabled. If the Hibernate setting is enabled, data collection stops when the computer goes into Hibernate mode.

1. Press the power button on the 7500 Fast Dx Real-Time PCR Instrument. The following occur:
   - The indicator lights on the lower left of the front panel cycle through a power on sequence.
     - If the green Power On indicator is flashing, make sure that the tray is closed.
     - If the red Error indicator is lit, see “Troubleshooting – Front Panel Indicators” on page 23.
   - When the green Power indicator is lit (not flashing):
     - Communication is established between the computer and the instrument.
     - The Windows XP operating system recognizes the instrument.

Troubleshooting

Troubleshooting – Front Panel Indicators

Condition: The red **Error** indicator is lit.

Press on the instrument door to ensure that it is closed.
If the green Power On indicator lights up, the open instrument door caused the error, and installation continues.

- If the red Error indicator remains lit:
  a. Open the instrument door.
  b. Pull the heated cover door to verify that it is closed.
  c. Close the instrument door.
If the green Power On indicator lights up, the open heated cover door caused the error, and installation continues.

- If the red Error indicator remains lit, verify that the Windows desktop is displayed on the computer. If the Windows desktop is not displayed:
  a. Power off the 7500 Fast Dx Real-Time PCR Instrument.
  b. Restart the computer.
  c. Wait until the Windows desktop appears.
If the green Power On indicator lights up, installation continues.

- If the red Error indicator remains lit:
  a. Verify that the USB cable is connected to the back of the instrument.
  b. Verify that the other end of the USB cable is connected to the computer.
If the green Power On indicator lights up, it indicates that the USB cable was not connected, and installation continues.
Troubleshooting – Front Panel Indicators (continued)

- If the red Error indicator remains lit:
  a. Power off the 7500 Fast Dx Real-Time PCR Instrument.
  b. Wait for 30 seconds.

- If the red Error indicator remains lit, contact Life Technologies technical support (see page 6) or your service representative.
Performing the Background Calibration

- Powering On the 7500 Fast Dx Real-Time PCR Instrument
- Performing the Background Calibration
- Powering Off the 7500 Fast Dx Real-Time PCR Instrument
- Creating a Background Plate (See page 27)
- Creating a Plate Document for the Background Calibration (See page 28)
- Performing the Background Calibration (See page 29)
- Analyzing the Background Calibration Data (See page 30)
About the Background Calibration

**Time Required**  30 minutes

**Materials Required**
- Powder-free Gloves
- Safety Goggles
- Centrifuge with plate adapter

**Purpose of the Background Calibration**
A background calibration measures the level of background fluorescence in the instrument. During a background calibration run, the instrument:

- Performs continuous reads of a background plate containing PCR buffer for 10 minutes at 60 °C.
- Averages the spectra recorded during the run and extracts the resulting spectral component to a calibration file.

The software then uses the calibration file during subsequent runs to remove the background fluorescence from the run data.

**When to Perform a Background Calibration**
Perform a background calibration:

- Monthly
- After replacing the lamp
Background Fluorescence

Fluorescence data collected by the Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument includes a fluorescent signal inherent to the instrument, commonly referred to as background fluorescence. Background fluorescence is a composite signal found in all spectral data. This signal consists of fluorescence from several sources, including:

- Background electronic signal
- Contaminants in the sample block
- The plastic consumable (plates and caps)

Guidelines for Calibration

- Always create a new background calibration plate.
- Make sure the centrifuge you use is clean. Before centrifuging, wipe down the bucket using a tissue.
- Handle the plates with care to prevent contamination. Do not place plates on a lab bench, which may contaminate the plate.

Creating a Background Plate

Materials Required

- Pipettor, 200-μL (with pipette tips)
- Deionized water
- 96-Well Fast Reaction Plate
- Optical Flat Caps
- Safety glasses
- Powder-free gloves

Creating a Background Plate

IMPORTANT! Wear powder-free gloves while creating the background plate.

1. Remove a 96-Well Fast Reaction Plate from its box and place it on a clean, dry surface.
2. Aliquot 20 μL of deionized water to each well of the reaction plate.
3. Seal the plate using optical flat caps.
Creating a Plate Document for the Background Calibration

1. Open a new plate document:
   a. If the Quick Startup document dialog box is open, select Create New Document.

2. If the Quick Startup document dialog box is not open, click (or select File » New).

3. Configure the New Document dialog box:
   a. Select Assay » Background.
   b. Select Container » 96-Well Clear.
   c. Select Template » Blank Document.
   d. In the Operator field, enter your name.
   e. In the Comments field, enter any additional information that you want to save to the file (such as the plate bar code).
   f. In the Plate Name field, enter: Background_<date in DDMMYY format>
      For example, the name for a plate run on May 31, 2005 would be: Background_310505.
   g. Click .

Notes

Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument Reference Guide
4. In the SDS software, select **File** ▶ **Save As** to access the Save As dialog box. If the Save in field does not display “SDS Documents,” navigate to D: drive ▶ AppliedBiosystems ▶ SDS Documents, then click **Save**.

5. In the Reason for Change Entry dialog box, enter a reason, then click **OK**.

### Performing the Background Calibration

1. Load the plate in the instrument.

   **Note:** If you cannot open the tray, the sample block may be in its raised position, locking the tray position. To lower the block, select **Instrument** ▶ **Calibrate**, then exit the ROI Inspector.

2. In the SDS software, start the run:
   a. Select the **Instrument** tab.
   b. Click **Start**.

   The instrument begins the background calibration run.

   **Note:** Before starting the run, the instrument may pause (up to 10 minutes) to allow the heated cover to reach the correct temperature.

Continue with “Analyzing the Background Calibration Data” on page 30.
Analyzing the Background Calibration Data

1. When the run is complete, click OK.

2. Click (or Analysis > Extract Background).

   The software extracts the background signal, then displays one of the following messages:

<table>
<thead>
<tr>
<th>If the software displays:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Background Extraction Complete</strong> – The analysis is successful.</td>
<td>Click OK, then go to step 3.</td>
</tr>
</tbody>
</table>
| **Image exposure is too low...** – The software stopped the extraction because several raw spectra are at or below the detectable threshold for the calibration. | a. Click No.  
b. Verify that the instrument contains the background plate.  
c. Test the lamp. See “Monitoring Lamp Status” on page 50.  
d. Run the background plate again.  
e. If the SDS software continues to display the Image exposure is too low... dialog box, click Yes, then go to step 3. |
| **Image exposure is too high...** – The run is unsuccessful. The software stopped the extraction because one or more raw spectra exceed the maximum limit for the 7500 Fast Dx Real-Time PCR Instrument. | Click No, then troubleshoot the failed run. See “Troubleshooting” on page 33. |
3. In the plate document, select the Results tab, then select the Spectra tab.

4. Select all wells of the plate document.

5. Inspect the raw data for irregular spectral peaks that exceed the following fluorescent standard units (FSU):

<table>
<thead>
<tr>
<th>Filter</th>
<th>FSU</th>
</tr>
</thead>
<tbody>
<tr>
<td>A, B, C, D</td>
<td>&gt;72,000</td>
</tr>
<tr>
<td>E</td>
<td>&gt;90,000</td>
</tr>
</tbody>
</table>

If one or more wells produce raw spectra that exceed the specified FSU, the background plate or the sample block could contain a fluorescent contaminant. Determine the source of the contamination. See “Troubleshooting” on page 33.

**WARNING** PHYSICAL INJURY HAZARD. During instrument operation, the sample block can be heated to 100 °C. Before performing the following procedure, be sure to wait until the sample block reaches room temperature.

When the run is complete, remove the background plate:

1. Press the tray to open it.
2. Remove the background plate.
3. Press the tray to move it into the instrument.
**Troubleshooting**

**Troubleshooting – Background Calibration**

**Condition: Cannot extract the data (background calibration failed)**

Signals that exceed 72,000 fluorescent standard units (FSU) are considered beyond the limit of normal background fluorescence for a 7500 Fast Dx Real-Time PCR Instrument. Such signals may indicate that either the background or the sample block contains fluorescent contaminants. Common contaminants include: ink residue from permanent pens, powder from disposable gloves, and dust.

To determine the source and location of the contamination:

1. In the plate document for the calibration:
   a. Select the **Results** tab.
   b. Select the **Spectra** tab.

2. Select all wells of the plate document.

3. Inspect the raw background data for an irregular spectral peak or peaks.
   Wells producing raw spectra that exceed 72,000 FSU are considered irregular and could be contaminated.
4. Locate the contaminated well position(s) by selecting successively fewer wells in the plate document. The items that follow show an example of how to determine the location of a contaminated well.

   a. In the Spectra tab, select columns 1-6. The raw data from the selected wells does not include the irregular peak. Therefore, the contaminated well must be in columns 7-12.

   b. Select columns 7-9. The raw data from the selected wells includes the irregular peak. The contaminated well must be in columns 7-9.

   c. Select wells in row E and below in columns 7-9. The raw data from the selected wells does not include the irregular peak. The contaminated well must be in the first four wells of columns 7-9.

   d. Finally, by selecting each of the wells from the first four wells of columns 7-9, you can determine the location of the contaminated well (B9).

5. Repeat step 4 until you identify the location of each contaminated well.
6. Create a new background plate (see page 27).
7. Perform a background calibration (see “Performing the Background Calibration” on page 29).
8. Click (or select **Analysis > Extract Background**).
9. Repeat step 4 on page 34 to examine the contaminated well position(s).
   If the contaminated well positions with the new background plate are:
   - In the same location as you saw in step 4, then the sample block is contaminated. Decontaminate the sample block (see “Decontaminating the Sample Block” on page 43).
   - No longer present, the original background plate was contaminated. You can inspect the original background plate. Make sure that there is no particulate matter on the bottom of the plate or on the cover.
10. If the calibration fails after you use a new background plate or decontaminate the sample block, perform the following test:
    a. Press the tray to open it.
    b. Load the black plate tool from the packing kit (or a plate containing a piece of black paper) into the plate holder.
    c. Push the tray back into the instrument.
11. Perform a background calibration (see “Performing the Background Calibration” on page 29).
    a. Click (or select **Analysis > Extract Background**).
    b. Select the **Results** tab, then select the **Spectra** tab.
    c. Select all wells of the plate document.
12. View the Spectral plot for the peak(s) and choose from the following:
   If the contaminated well is:
   - Present, then the optics of your 7500 Fast Dx Real-Time PCR Instrument may be contaminated. Contact Life Technologies technical support or your service representative for further assistance.
   - Absent, then the sample block is contaminated. Decontaminate the sample block (see “Decontaminating the Sample Block” on page 43).
Powering Off the 7500 Fast Dx Real-Time PCR Instrument

Powering On the 7500 Fast Dx Real-Time PCR Instrument

Performing the Background Calibration

Performing a Short-Term Shutdown  See page 38

Performing a Long-Term Shutdown  See page 39

Powering Off the 7500 Fast Dx Real-Time PCR Instrument

Notes

Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument Reference Guide
Performing a Short-Term Shutdown

Perform the short-term shutdown procedure if you will use the instrument within 7 days.

**Time Required**

5 minutes.

**Performing a Short-Term Shutdown**

1. Press the tray to open it.

2. If the tray contains a plate, remove it, then press the tray to move it into the instrument.

3. Press the instrument power button.
4. Power off the computer and monitor:
   a. Select \textcolor{blue}{Start} \textcolor{red}{\Rightarrow} \textcolor{green}{Shut Down}.
   b. In the Shut Down Windows dialog box (not shown), select \textcolor{green}{Shut Down}.
   c. Power off the monitor.

### Performing a Long-Term Shutdown

Perform the long-term shutdown procedure if the instrument will be inactive for more than 7 days.

**Time Required**

5 minutes

**Materials Required**

Plate, packaging

**Performing a Long-Term Shutdown**

1. Press the tray to open it.
2. If the tray contains a plate, remove it.
3. Load the packaging plate into the tray.

   \textbf{Note:} If the shipping plate is not available, substitute an unused reaction plate. During storage, the instrument optics block rests on the plate to protect the optics block.

4. Press the tray to move it into the instrument.
5. Press the instrument power button.
6. Power off the computer and monitor:
   a. Select \[\text{Start} \rightarrow \text{Shut Down}\].
   b. In the Shut Down Windows dialog box (not shown), select \[\text{Shut Down}\].
   c. Power off the monitor.
Maintaining the Instrument

- Recommended Maintenance Schedule ............................................. 41
- Archiving and Backing Up SDS Files .............................................. 42
- Decontaminating the Sample Block ............................................... 43
- Cleaning Up and Defragmenting the Hard Drive ............................... 47
- Moving the 7500 Fast Dx Real-Time PCR Instrument ......................... 48
- Monitoring Lamp Status ............................................................... 50
- Replacing the Instrument Fuses ...................................................... 51

**Recommended Maintenance Schedule**

**Weekly Maintenance Tasks**
- Check disk space
- Archive or back up SDS plate document files (see page 42)
- Cycle the computer and instrument power (power off, then power on the computer and instrument)
- Wipe instrument surfaces with a lint-free cloth

**IMPORTANT!** Never use organic solvents to clean the 7500 Fast Dx Real-Time PCR Instrument.

**Monthly Maintenance Tasks**
- Perform a background calibration (see page 29)
- Clean up and defragment the computer hard drive (see page 47)
Appendix A  Maintaining the Instrument

Archiving and Backing Up SDS Files

**Semi-Annual Maintenance Tasks**

Performed by Life Technologies Service Personnel. Customer is responsible for contacting Life Technologies to schedule maintenance tasks.

![Monthly Calendar](image)

**Miscellaneous Maintenance Tasks**

Perform the following tasks as needed to resolve problems as they arise:

- Decontaminate the sample block (see page 43)
- Move the 7500 Fast Dx Real-Time PCR Instrument (see page 48)
- Replace the instrument fuses (see page 51)

**Archiving and Backing Up SDS Files**

**Archiving SDS Files**

To conserve space on the computer hard drive, SDS plate document files can be archived using a data compression utility. Several commercially available compression utilities are available. PKZIP and *.arc are archive formats common to the Microsoft® Windows® operating system.

**Backing Up SDS Files**

Life Technologies strongly recommends that you back up the plate documents generated by your 7500 Fast Dx Real-Time PCR Instrument because backing up:

- Protects against potential loss of data caused by an unforeseen failure of the computer or its hard drive(s).
- Conserves space on the hard drive and optimizes performance, if you remove old data after backing up.

**Developing a Data Management Strategy**

Life Technologies recommends developing a strategy for dealing with the files produced by the SDS software. During a single day of real-time operation, the 7500 Fast Dx Real-Time PCR Instrument can generate over 10 MB of data. Data management is a concern only if you perform absolute or relative quantitation experiments on your 7500 Fast Dx Real-Time PCR Instrument. These real-time runs generate significantly more data than allelic discrimination or plus/minus experiments.

**Checking Disk Space**

If you perform real-time experiments on your 7500 Fast Dx Real-Time PCR Instrument, check the amount of available space on your hard drive weekly. When the hard drive is within 20% of maximum capacity, transfer the older data to a backup storage device.

---

**Notes**

---

42  Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument Reference Guide
Decontaminating the Sample Block

⚠️ **WARNING** PHYSICAL INJURY HAZARD. Do not remove the instrument cover. There are no components inside the 7500 Fast Dx Real-Time PCR Instrument that you can safely service yourself. If you suspect a problem, contact a Life Technologies Service Representative.

⚠️ **WARNING** PHYSICAL INJURY HAZARD. During instrument operation, the sample block can be heated to 100 °C. Before performing the following procedure, be sure to wait until the sample block reaches room temperature.

⚠️ **CAUTION** Before using a cleaning or decontamination method other than those recommended by the manufacturer, verify with the manufacturer that the proposed method will not damage the equipment.

For the SDS of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer and observe all relevant precautions.

The following procedure explains how to eliminate fluorescent contaminants from the sample block of the 7500 Fast Dx Real-Time PCR Instrument. Perform the procedure to resolve problematic background runs where one or more wells consistently exhibit abnormally high signals, indicating the presence of a fluorescent contaminant.

**Time Required**

30 minutes

**Materials Required**

- Pipette (100-µL) with pipette tips
- 95% ethanol solution
- 10% bleach solution
- Deionized water
- Cotton or nylon swabs and lint-free cloths
- Safety glasses
- Powder-free gloves
- Screwdriver

Notes

---

Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument Reference Guide
Cleaning the Sample Wells

**IMPORTANT!** Wear powder-free gloves when you perform this procedure.

1. Identify the contaminated wells of the sample block (see “Troubleshooting” on page 33).

2. Remove the plate and the tray holder.

3. Close the tray. Apply pressure to the right side of the tray and at an angle.

4. Manually raise the block from the ROI Inspector window:
   a. If the Quick Startup document dialog box is open, select **Create New Document**. If the Quick Startup document dialog box is not open, click (or select **File** ➤ **New**).
   b. In the New Document wizard, click .
   c. In the SDS software, select **Instrument** ➤ **Calibrate**.
   d. In the warning dialog box, click to lower the sample block. The ROI Inspector dialog box opens.
   e. In the ROI Inspector dialog box, click .

5. Power off, then unplug the 7500 Fast Dx Real-Time PCR Instrument. Allow it to cool for 15 minutes.
6. Open the access door to the 7500 Fast Dx Real-Time PCR Instrument.
   a. Insert a thin screwdriver into the keyhole on the edge of the access door, then push to unlatch the door.
   b. Open the access door.

7. Lift the latch, then push the heated cover door to the back of the instrument.

8. Clean the contaminated wells of the sample block using a small volume of deionized water:
   a. Pipette a small volume of deionized water into each contaminated well.
   b. Pipette the water up and down several times to rinse the well.
   c. Pipette the water to a waste beaker.
   d. Using a cotton swab, scrub the inside of each contaminated well.
   e. Using a lint-free cloth, absorb the excess deionized water.
9. Pull the heated cover door to the front of the instrument. Lift the latch, then secure the heated cover door to the cross bar.

10. Plug in, then power on the 7500 Fast Dx Real-Time PCR Instrument.

11. Create a new background plate (see “Creating a Background Plate” on page 27.)

12. To confirm that you have eliminated the contamination, perform a background calibration run (see “Performing the Background Calibration” on page 29).

13. If the contamination is still present, repeat steps 1 through 7, then go to step 14.

14. Clean the contaminated wells of the sample block using a small volume of 95% ethanol solution:
   a. Pipette a small volume of 95% ethanol solution into each contaminated well.
   b. In each contaminated well, pipette the solution up and down several times to rinse the well.
   c. Pipette the ethanol solution to a waste beaker.
15. Repeat steps 8 through 12 to rinse the wells of the sample block and to verify that you have eliminated the contamination.

If the contamination is still present, repeat steps 1 through 7, then go to step 16.

**IMPORTANT!** Always use deionized water to rinse wells after cleaning with bleach or ethanol solution.

16. Clean the contaminated wells of the sample block using a small volume of 10% bleach solution:

   a. Pipette a small volume of 10% bleach solution into each contaminated well.

   b. In each contaminated well, pipette the solution up and down several times to rinse the well.

   c. Pipette the bleach solution to a waste beaker.

17. Repeat steps 8 through 12, to rinse the wells of the sample block, and to verify that you have eliminated the contamination.

**IMPORTANT!** Always use deionized water to rinse wells after cleaning with bleach or Ethanol solution.

If contamination is present, contact Life Technologies technical support (see page 6).

18. Ensure that the heated cover door is completely closed and latched. If it is not, an error message is displayed.

---

**Cleaning Up and Defragmenting the Hard Drive**

**When to Clean Up and Defragment the Hard Drive**

- At least once every month
- When a message is displayed by the Windows operating system instructing you to defragment
Cleaning Up the Disk

1. In the Windows desktop, select **Start** ➔ **All Programs**.
2. Select **Accessories** ➔ **System Tools** ➔ **Disk Cleanup**.
3. Select the drive to clean up, then click **OK**. Click **OK** at any additional prompts.
4. Repeat for remaining drives.

Defragmenting

1. In the Windows desktop, select **Start** ➔ **All Programs**.
2. Select **Accessories** ➔ **System Tools** ➔ **Disk Defragmenter**.
3. At the top of the dialog box, select the Volume (hard drive) to defragment.
4. Click **Defragment**.
5. When the Defragmentation Complete dialog box displays, click **Close**.
6. Repeat steps 3 through 5 for the remaining drives on the computer.

Moving the 7500 Fast Dx Real-Time PCR Instrument

⚠️ **WARNING** PHYSICAL INJURY

HAZARD. Do not attempt to lift the instrument or any other heavy objects unless you have received related training. Incorrect lifting can cause painful and sometimes permanent back injury. Use proper lifting techniques when lifting or moving the instrument. At least 2 people are required to lift the 7500 Fast Dx Real-Time PCR Instrument.
IMPORTANT! Moving your 7500 Fast Dx Real-Time PCR Instrument can create subtle changes in the alignment of the instrument optics.

Instruments should be moved only by Life Technologies authorized personnel. If instruments are moved, performance must be verified by Life Technologies personnel.
Monitoring Lamp Status

Checking Status  To determine whether the halogen lamp has enough electrical current:

1. Click (or select File → New).

2. In the New Document wizard, click Finish.

3. In the SDS software, select Instrument → Lamp Status/Replacement.

In the Lamp Status/Replacement dialog box, the Lamp Current: field indicates a amperes figure for the electrical current. The Condition: field indicates one of the following:

- **Good** – The lamp is functioning well. There is no need to replace the lamp bulb at this time. Click Close.

- **Failed** – The lamp bulb must be replaced. Click Close, then contact your local Life Technologies service representative to have the lamp bulb replaced.

- **Change Soon** – The lamp bulb usage is above 2000 hours. It is recommended to have the lamp changed soon. Click Close, then contact your local Life Technologies service representative to have the lamp bulb replaced.

Warning Messages  Three warning messages can be displayed before or during a run that indicate low lamp current:

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Warning</strong> – Cannot detect sufficient current from lamp. Either lamp is not installed properly or needs to be replaced.</td>
<td>Displayed at the start of a run if the lamp current has fallen below the acceptable level. You cannot proceed with the run. You must have the halogen lamp replaced.</td>
</tr>
<tr>
<td><strong>Warning</strong> – Cannot detect sufficient current from lamp. Either lamp is not installed properly or needs to be replaced.</td>
<td>Displayed if the lamp current falls below the acceptable level during a run. The run is terminated. Click OK in the message box, inspect the Instrument Log, then have the lamp replaced. You cannot proceed with the run. You must have the halogen lamp replaced.</td>
</tr>
<tr>
<td><strong>Warning</strong> – The lamp usage has exceeded 2000 hours. We recommend replacing the lamp soon to ensure optimal assay performance.</td>
<td>Displayed at the start of a run if the lamp usage exceeds 2000 hours. Click Cancel Run, then have the lamp replaced, or click Continue Run.</td>
</tr>
</tbody>
</table>

Notes
If the lamp needs replacement, contact your Life Technologies service representative.

## Replacing the Instrument Fuses

FIRE HAZARD. For continued protection against the risk of fire, replace fuses only with listed and certified fuses of the same type and rating as those currently in the instrument.

**Time Required**

30 minutes

**Materials Required**

- Powder-free gloves
- Flathead screwdriver
- Fuses (2), 12.5A, 250V, 5 x 20 mm
- Safety glasses

**Replacing the Fuses**

1. Turn off the instrument, then unplug it.

2. Using a flat-head screwdriver, unscrew and remove the fuse holders from the instrument.

---

Notes
3. Remove each fuse from its fuse holder and inspect it for damage. Carbon typically coats the inside of failed fuses.

4. Replace failed fuses with a 12.5A, 250V, 5 x 20-mm fuse.

   **Note:** The voltage and amperage ratings are on the fuse holder.

5. Replace the fuse holder into the instrument.

6. Plug in, then power on the instrument.

   The installation is successful if the instrument powers on.

   **Note:** Fuse failure can result from fluctuations in the supplied power to the instrument. To prevent further failures, consider installing an electrical protective device.
Specifications

- System Component Dimensions and Weights ................................. 53
- Clearance and Layout Specifications ........................................... 53
- Environmental Specifications ..................................................... 55
- Ventilation Specifications ......................................................... 55
- Electrical Specifications .......................................................... 56
- Environmental Conditions for Transport and Storage ..................... 56

System Component Dimensions and Weights

<table>
<thead>
<tr>
<th>Component</th>
<th>Width, cm (in)</th>
<th>Depth, cm (in)</th>
<th>Height, cm (in)</th>
<th>Weight, kg (lbs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument</td>
<td>34 (13.4)</td>
<td>45 (17.8)</td>
<td>49 (19.3)</td>
<td>34.1 (75.0)</td>
</tr>
<tr>
<td>Computer (laptop)</td>
<td>31.5 (12.4)</td>
<td>25.7 (10.1)</td>
<td>28.7 (11.3)</td>
<td>2.27 (5)</td>
</tr>
<tr>
<td>Computer (desktop)</td>
<td>19.1 (7.4)</td>
<td>42.7 (16.8)</td>
<td>45.0 (17.7)</td>
<td>6.8 (15.0)</td>
</tr>
<tr>
<td>Monitor</td>
<td>43.2 (17)</td>
<td>25.4 (10)</td>
<td>45.7 (18)</td>
<td>6.8 (15.0)</td>
</tr>
<tr>
<td>Keyboard</td>
<td>45.7 (18)</td>
<td>17.8 (7)</td>
<td>5.1 (2)</td>
<td>0.9 (2.0)</td>
</tr>
</tbody>
</table>

Clearance and Layout Specifications

- Clearance on all sides – At least 15.2 cm (6 in) of clearance for ventilation, service access, and cable routing. Allow space for the Life Technologies service representative to move the instrument for easy access to the back and sides.

Notes

__________________________________________

Applied Biosystems 7500 Fast Dx Real-Time PCR Instrument Reference Guide 53
• **Vertical clearance** – At least 30.5 cm (12 in) of unobstructed vertical clearance above the top of the 7500 Fast Dx Real-Time PCR Instrument to allow the top to be lifted during service.

**Note:** In the following figure, the shaded region (□) around the 7500 Fast Dx Real-Time PCR Instrument indicates the required clearance (empty space).

Instrument location must:

- Not be adjacent to heaters, cooling ducts, or in direct sunlight.
- Allow the computer to be within 2 m (6 ft) of the instrument.
- Allow positioning the monitor, keyboard, and accessories for proper ergonomics during use.
- Allow you to easily access and disconnect the power cord.
Environmental Specifications

- **Altitude**: The 7500 Fast Dx Real-Time PCR Instrument is for indoor use only and for altitudes not exceeding 2000 m (6500 ft) above sea level.

- **Temperature**: 15 to 30 °C (59 to 86 °F). Maximum change of less than 15 degrees Celsius (27 degrees Fahrenheit) per 24 hrs. Avoid placing the system adjacent to heaters, cooling ducts, or in direct sunlight. Fluctuations between day and night temperatures can cause system instability.

- **Humidity**: 20 to 80% relative humidity, noncondensing.

**IMPORTANT!** The temperature and humidity conditions must be maintained even when the 7500 Fast Dx Real-Time PCR Instrument is not in use.

- **Pollution Requirement** – The location cannot exceed Pollution Degree II - Only nonconductive pollutants, if any, are present.

  The 7500 Fast Dx Real-Time PCR Instrument has a pollution degree rating of II and may be installed in an environment that has nonconductive pollutants (dust, wood chips, and so on) only. Typical environments with Pollution Degree II ratings are laboratory, sales, and commercial areas.

  Pollutants may negatively affect the performance of the 7500 Fast Dx Real-Time PCR Instrument.

Ventilation Specifications

- Normal room ventilation system must maintain room temperature if the maximum thermal output of the 7500 Fast Dx Real-Time PCR Instrument (see below) is vented directly into the room air.

  Hot-air exhaust is vented from the 7500 Fast Dx Real-Time PCR Instrument through the hot-air waste port on the rear panel. The hot-air exhaust is designed to dissipate heat produced by the instrument. The maximum thermal output of the 7500 Fast Dx Real-Time PCR Instrument is 3241.5 Btu/h (950 W). Consult your facilities department to determine if the laboratory ventilation system can maintain room temperature with this level of thermal output. If it can maintain room temperature during instrument operation, the hot-air exhaust port can be vented directly to room air.

- A suitable venting device such as a fume hood or fume duct must be available to vent the hot air exhaust from the instrument space.
Electrical Specifications

- **Main Power Supply** – The main power supply to the instrument must be accessible.

  **Note:** In case of emergency, you must be able to immediately disconnect the main power supply to the 7500 Fast Dx Real-Time PCR Instrument.

- **Power Connectors and Receptacles** – Grounded power receptacles must be available to support the electrical requirements shown below.

<table>
<thead>
<tr>
<th>Location</th>
<th>Input Voltage (VAC)</th>
<th>Frequency (Hz)</th>
<th>Nominal Current Draw (A)</th>
<th>Power (W)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japan</td>
<td>100</td>
<td>50/60</td>
<td>9</td>
<td>950</td>
</tr>
<tr>
<td>USA/Canada</td>
<td>120</td>
<td>50/60</td>
<td>8</td>
<td>950</td>
</tr>
<tr>
<td>European Union</td>
<td>230</td>
<td>50/60</td>
<td>4</td>
<td>950</td>
</tr>
<tr>
<td>UK/Australia</td>
<td>240</td>
<td>50/60</td>
<td>4</td>
<td>950</td>
</tr>
</tbody>
</table>

The 7500 Fast Dx Real-Time PCR Instrument can be configured for operating voltages between 100 and 240 V AC at 50 or 60 Hz. The system is equipped with a universal power supply. The instrument requires a 15 A circuit for all indicated input voltages.

**IMPORTANT!** The 7500 Fast Dx Real-Time PCR Instrument is shipped to customers with up to three power connectors. These connectors require standard 15 A wall receptacles with proper grounding. Do not use extension cords.

At 110 V, the computer monitor has a nominal current draw of 0.9 A; at 240 V, the current draw is 0.4 A.

- **Power Line Regulator** – A power line regulator is needed if the voltage of the supplied power often fluctuates more than ±10% of the nominal value.

  High and low voltages can adversely affect the electronic components of the 7500 Fast Dx Real-Time PCR Instrument.

Environmental Conditions for Transport and Storage

- **Temperature:** – 30 °C to +60 °C.
- **Humidity:** 20 to 85% relative humidity.
Index

A
analyzing background data 30
archiving SDS files 42
assumptions for using this guide 5

B
background calibration
analyzing the data 30
creating the plate document 28
materials required 26
performing 29
purpose 26
time required 26
when to perform 26
background component, about 27
background plate
creating 27
running 29
backing up SDS files 42
biohazardous waste, handling 16
biological hazard guidelines 17

C
calibration, background 26
CAUTION, description 8
calculated safety 14, 15
chemical waste safety 15
cleaning the sample block 43
computer
   cleaning up the disk 47
defragmenting the hard drive 47
contamination
decommissioning the sample block 43
locating on the sample block 33
conventions
   IMPORTANTS! 5
   in this guide 5
   Notes 5
   safety 8
   user attention words 5
creating
   background plate 27
   background plate document 28

D
DANGER, description 8
data management 42
decontaminating the sample block 43
defragmenting the hard drive 47
disk cleanup 47
disk space, checking 42
documentation, related 6

E
electrical requirements 56
electrical safety 16
electromagnetic compatibility standards. See EMC standards
EMC standards 19
ergonomics, safety 18
error status light, troubleshooting 23

F
front panel indicators
   location 22
   troubleshooting 23
fuses, changing 51

G
guidelines
   chemical safety 15
   chemical waste disposal 15
   chemical waste safety 15

H
hazard icons. See safety symbols, on instruments
hazard symbols. See safety symbols, on instruments
hazards. See safety

I
IMPORTANT, description 8
indicator lights
   location 22
   troubleshooting 22
Index

installation category 17
instrument indicator lights 22
moving 48
powering on 22
shutting down 37
instrument operation, safety 13

L
lamp status, checking 50
warning messages displayed when running 50
Life Technologies
contacting 6
Technical Support 6
long-term shutdown 39

M
maintenance miscellaneous 42
monthly 41
schedule 41
semi-annual 42
weekly 41
moving and lifting, safety 13
moving parts, safety 17
moving the instrument 48
MSDSs
description 14
obtaining 14

O
overvoltage category (rating) 17

P
physical hazard safety 17
plate document, background 28
plate, background 27
powering off the instrument 37
powering on the instrument 22

R
radioactive waste, handling 16
red status light, troubleshooting 23
repetitive motion, safety 18
replacing instrument fuses 51
requirements
electrical 56
space 53
ROI Inspector 44
running background plate 29

S
safety
before operating the instrument 13
biological hazards 17
chemical 14
chemical waste 15
conventions 8
electrical 16
ergonomic 18
guidelines 15, 16
instrument operation 13
moving and lifting instrument 13
moving parts 17
moving/lifting 13
physical hazard 17
repetitive motion 18
standards 19
workstation 18
safety labels, on instruments 11
safety standards 19
safety symbols, on instruments 9
sample block, decontaminating 43
semi-annual maintenance tasks 42
short-term shutdown 38
shutting down the instrument 38
space requirements 53
standards
EMC 19
safety 19
status lights, front panel 23
powering up 22
symbols, safety 9
system
dimensions 53
weight 53

T
Technical Support, contacting 6
text conventions 5
training, information on 6
troubleshooting
background calibration 33
cannot extract background data 33
cannot extract optical calibration data 33
indicator lights 22
lamp status 50
optical calibration 33
powering on 23
red Error indicator is lit 23
Index

U
user attention words, described 5

W
WARNING, description 8
waste disposal, guidelines 16
weekly maintenance tasks 41
workstation safety 18